World of Fiery ® Webinar FAQ
Advanced color management for digital print systems

Thank you for your interest in our World of Fiery Webinar, this FAQ answers the questions from the session. If you would like to view
it again or share it, please access the recording of the webinar here.

Color Quality
How do I get the best quality out of the bright colors from my printer? We have a lot of trouble from people wanting
bright pinks and oranges. How do we best utilize our EFI ES-2000?
First, you need to see if the bright colors are defined in the job as RGB or spots. If they are CMYK, they might look bright on the
screen but won't be as bright in device color space. You also need to know if these colors are in gamut for the printer. Are you
making custom profiles? If so, the Profile Inspector in Fiery Color Profiler Suite will let you plot the gamut of the output profile you
made. Now make one of these bright colors into a spot color by putting it in a custom library in Spot-On, export the library, and drag
the exported library into the Inspector, and you can see if it plots within the color gamut.
See the image below where I plotted a bright pink that is not in gamut for a coated profile on a sample device. Note also that the
better the paper the more likely you will hit these colors. If you are using an uncoated sheet, you probably can’t even match ISO or
GRACoL, much less bright spot colors.
The main uses of the ES-2000 are to calibrate the Fiery server and to make new calibration and profiles for each paper type. It is also
used to verify color precision with the Verify module of Fiery Color Profiler Suite.

Why do certain colors like lime green and some bright electric blues print better if I leave the file in RGB color
settings when it is printing on a CMYK digital machine?
You are probably clipping these colors to a standard like SWOP or GRACoL if you pre-convert them. RGB takes advantage of the
gamut of the output profile without over compression.

Our printer prints too red. How do we solve this?
The most probable cause is lighting. Prints often look reddish in fluorescent light. Do prints look more neutral in the light booth (or in
sunlight if you have no light booth)? If not you need to make a custom profile that uses more black and less of the CMY. Replacing
colors with black is called “Gray Component Replacement” (GCR). If you use Fiery Color Profiler Suite, enable the Max GCR setting
when you make the profile. Then you can print the color test page at the end of the calibration and profile creation and look at the
neutral image to ensure that the prints aren’t too red (or any other color) with the new calibration and profile applied.
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How can I reduce magenta in prints and how can I print a good dark blue? They all look a little purple.
For magenta in prints see answer above. For blues, are the objects RGB in the PDF or PostScript print job? If so use the sRGB or
Adobe RGB source profile and Relative Colorimetric Rendering intent on the Fiery server. If the problem persists post more details
on the Fiery Color Forum.

How can I print a good gradient without banding and solid areas of color without looking modeled, especially black?
To print a gradient without banding, try different screening and resolution settings on the Image tab of Job Properties. The smoothest
halftone screen is typically the one used for the IDEAlliance Digital Press Certification for your print system, so try looking it up online
and downloading the Application Data Sheet (ADS) for the certification. The document describes what screen setting was used in
section IV.

What settings will improve shadow detail?
For RGB, try Photographic Rendering intent. For CMYK, you could check if there is an embedded profile using Enfocus PitStop. If
there is, turn on Use Embedded Profiles if Present for CMYK; this will treat it as “Lab” so it would also use Photographic intent.

Why is the color different when I print from file and when I import it to Command WorkStation? The color completely
changes.
The main reason is that when you bring a file into Command Workstaton is uses its embedded color definitions if any. When you print
from an application, the application determines the color that is embedded into the file; if you set “Let Printer Manage Colors” from an
Adobe CS program, the colors are all defined as device independent and you need to enable Use Embedded Profiles on the Fiery to
take advantage of them. If you set “Let Application Manage Colors” then all the colors are converted into the space of the profile you
specify when printing. In this case you need to make sure that profile is used on the Fiery for the input color space. Also, settings in
the print driver can be different than what is used when you import the file. For the best consistency always import files since if you
have multiple users printing from applications they are likely to use different settings and it will be hard to get a re-print to match later
since you won’t know what settings were used on the initial run.

Specialty and Spot Colors
Is there a way to use the spectrometer to match spot colors?
To capture a new spot color from an item like a business card, use the ES-2000 or ES-1000 in Spot-On to add a new custom color.
To make spot colors match better by measuring, use the Device Linker from Fiery Color Profiler Suite or simply go to Spot-On in
Command WorkStation on the same machine where Fiery Color Profiler Suite is installed and licensed, right-click on the color you
want to improve, and select “Optimize” to launch Device Linker and optimize the color.

Do systems with a 5th Channel (white, clear, silver, gold, etc.) get managed outside of the Color Management
System?
Yes, these specialty colors are treated like spot colors and so are not color managed.

How do I match colors from PowerPoint? I save PowerPoint presentations to PDF and then print but our house blue
does not match when printed.
PowerPoint cannot use spot colors. If you can find the tint (maybe with Enfocus PitStop) then you can make a substitute color for that
in Spot-On for precise color output of your blue.
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Do embedded ICC profiles affect the appearance of spot colors?
Not at all. Spots are named colors that have no profile assigned. They are color managed based entirely on their names and the
device values calculated (or edited) in Spot-On.

Matching
When I'm struggling to match a difficult color and finally get it, how do I ensure that I can achieve that again without
all the adjustments?
It depends on the tools you are using for correction. If they are Fiery server setting/edits, you can archive the job to retain the
settings. The professional way is to make a custom calibration and profile for your press and paper type, calibrate every day and
verify every day. Are your ∆E’s staying consistent over time? If not, you will occasionally need to re-make the profile to get back to
the same ∆E values. If the system is stable then your settings/corrections will work the next time. For important jobs with high-value
reprints, it’s often better to fix and save the source documents on the first run rather than tweaking it on the Fiery server since it will
be hard to remember how to re-tweak the file to match on a reprint.

What is the best process to match my Indigo 7600 output?
The easiest way is if you have a custom output profile made for the Indigo is to try using that as the CMYK source profile on the Fiery
server. You’ll need to do this for a specific paper type and if it works then bring over the other Indigo profiles for other paper types.
This will only work if you have made custom profiles for the Indigo.
You can also try making custom profiles for both presses and matching them to the same reference like GRACoL, SWOP or ISO. To
enhance your results, consider making device link profiles. You can ask questions on the Fiery Color Forum as you try these steps
and we’ll guide you.

Would like to know if there are any tricks to getting spot colors to match even closer between 2 different digital
devices?
Have you made custom profiles for each device? Try optimizing the spot color using Fiery Color Profiler Suite. If you don’t have it,
another idea would be to take the preferred print from the machine you want to match, then go edit the color on the other machine.
Use the ES-2000 to measure the print you prefer to better match it on the other machine with Spot-On.

How can I match up monitor colors to output colors on the MFP?
First, you need to make a custom monitor profile with a tool like Fiery Color Profiler Suite. Then it depends on the application you
view the color in. If it is Adobe Creative Suite, then it is good news. These applications simulate printed output if you set up Proof
Preview and tell it to preview the source space of the document like GRACoL. If you have RGB data, you’ll need to set Proof Preview
to show the output profile you will print with on the Fiery server that you can export then load into the machine where the Creative
Suite is. If you’re stuck on how to do this, please post a question on the Fiery Color Forum online.
If you want to match colors from Command WorkStation, you’ll need the Fiery ImageViewer option. Be aware that these steps will get
it closer, but will not be a perfect match to the print. If you want a perfect screen-to-print match you need to get a dedicated high end
softproofing display and a D50 light booth that can be dimmed to put next to the display. Expect to spend about $5000 US minimum
for such a setup.
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Paper
Is there a function in the printer that I can use to make profiles for our different papers using our instrument, i1pro2?
Yes, you need to buy Fiery Color Profiler Suite software, and it will make profiles with these instruments you already have.

How do you make a profile for a certain paper?
Fiery Color Profiler Suite Express Profiler is the easiest way; it makes a calibration and profile in 5 steps for the paper type you
select.

Do all Fiery systems have the ability to create custom output profiles for different paper types? We do not have all
options on ours so don't know if that is possible. How can one tell and if we don't have that ability? What is the best
workaround?
Yes, all Fiery systems can take custom profiles and most can create multiple calibration sets. Fiery Color Profiler Suite will create
custom profiles for any Fiery server and custom calibration sets for all the Fiery systems that support this custom calibration (95% or
more). Even if a calibration cannot be customized, a custom profile made with Fiery Color Profiler Suite will always give the best
result.

Why is it possible to get color differences by just changing the paper size (same paper quality, same printer, same
day, same tray)?
Are you using Paper Catalog for each paper? If so, look what profiles are assigned in each entry. If not, please post your question
again to Fiery Color Forum with all the details of the steps you are taking.

How do I assign a profile to a populated paper catalogue from the engine?
Open it in Command WorkStation > Device Center > Resources and set the profiles for front and back.

Profiles
When we select "Use Embedded Profile" in Command WorkStation, are we shown the name of this profile
anywhere?
No, it is not shown since a PDF or PostScript file may have multiple color definitions embedded. If you have a PDF you can see what
the embedded profiles are with Enfocus Pitstop.

When would you use the bypass input profile setting?
There is no setting to bypass, only to use embedded profiles. You would turn this off if you are having problems with printing black
and white only pages as black only (at least CMYK ones).

Do we use embedded profile or convert in the Adobe Applications?
Always use embedded profiles so you can see the image appearance when opening. If it looks great you might want to convert to
your working space before you save so that you don’t get the warning the next time. If you know the source of images and trust the
embedded without seeing the image then you can convert on opening. Also, if you use the embedded and the image looks bad, try
assigning a profile that gives a good appearance then converting to your working space and saving.
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We receive all of our files in PDF, is there a way to tell what color profile is embedded or would this information need
to be provided from the designer?
Use Enfocus PitStop Inspector to identify embedded color definitions. If they are all the same, set these as the defaults on the Fiery
server. If they change from object to object, set Use Embedded for RGB and/or CMYK depending on if it is RGB or CMYK objects
that you find have mixed color definitions in the PDF.

Illustrator setting "ignore CMYK profile", does that mean that the output intent profile is ignored?
Ignore embedded means ignore the fact that the CMYK values were defined with the embedded profile and open the file without
changing the CMYKs but assigning them the different CMYK working space of Illustrator. This means the color-managed appearance
of the CMYK will change. I don’t think Illustrator honors the PDF/X Output intent tag when opening a file although when you save an
Illustrator file as PDF there is a way to specify what profile to put in the Output Intent tag when saving PDF/X.

Is there a way to select images and graphics that are the same color across a multiple page document to change the
color profile, instead of only being able to select what is on the current page?
The simple answer is that when you save or export a PDF it may get one set of color configuration, and when you print depending on
the settings from the application. We need to know how you are saving the PDF,the exact way you are printing, and from what
application. If you can post all this detail in a question on the Fiery Color Forum, we can help you more.

Calibration
For the best results and to maintain color consistency, should I calibrate several times a week or once a week?
Our recommendation is to calibrate once a day. Calibration frequency depends on the environment and the workload. If you print
multiple shifts, you should consider calibrating every shift. If you put a thermometer and a hygrometer in the pressroom and the
temperature is changing by more than 5° F or the humidity is changing by more that 3-5% over time, you need to calibrate more
frequently. If temperature and humidity remain constant over time, then you could calibrate once a week.

When calibrating, do we put plain white paper underneath while scanning in strips?
Yes, use a few sheets of the same paper you are measuring under the calibration patch page. It is very important the measuring
instrument is level to be precise, so don’t throw off the angle by using lots of sheets behind the sample.

Is there a way to calibrate the machine without the calibrator?
You can try to do it off the glass with the ColorCal feature but this takes longer and does not do nearly as good a job as the ES-2000.
Given what you have already invested in the press and print system, it is well worth the investment to add a quality
spectrophotometer to your operation for precise calibration..

My Fiery server doesn't have the "Black Point Compensation" check box in the Color Input. Where do I find this?
Black Point Compensation was added in more recent Fiery systems. Your Fiery system will do Black Point Compensation on most
page objects automatically.

5
3/11/2016

World of Fiery ® Webinar FAQ
Advanced color management for digital print systems
How do you calibrate to a different resolution? I do not remember a choice when I go to calibrate to tell it which
resolution I am using.
When you create a calibration set, the resolution comes from the Image tab in Job Properties. Usually, this is the server default so
unless you ever change it, it will be the same when you re-calibrate. If you are using Factory calibration sets, then they are always
created at the default resolution for the print system.

When you calibrate, should you use only white paper, or use the type of paper you are printing on?
You should use the paper you are printing on ideally with the calibration you made for it when you profiled it.

Grayscale, Black and White, and Color Clicks
Is it true if you just set print as grayscale there may be a color click without setting to Pure Black?
No. Printing in grayscale mode will only produce a black and white click charge. If you are printing in color mode then you need to set
gray and black processing and pure black on to get black and white click charges.

Is it possible to get charged a 4 color click from registration marks that are still set to 4 color despite changing job
properties to grayscale?
If you set print mode to grayscale, you’ll always get only black and white clicks. Features to print blacks and grays with black only are
for when you have mixed jobs with some color and some grayscale pages that you want to print K-only. If these grayscale pages
have registration marks of color “All” then they’ll give you color clicks. To fix this, add a spot color called “All” in Spot-On and define it
as CMY = 0%, K = 100%.

We have a file that is full color on one side and pure black on the other. After ripping and printing, the printer clicks
color for both sides. What setting do we need to use to make sure the pure black side clicks black only at the
printer?
Turn on CMYK Gray processing to Text/Graphics/Images if it’s a CMYK K only page. If it’s RGB, you need to change the Gray
processing for RGB to Text/Graphics. If the pure black side is made up as a vector graphic, set to Text/Graphics. If the pure black
side is filled with an image, set to Text/Graphics/Images. In either case also set Pure Black on.

Is there a way to combine color clicks and black clicks in a single multi sheet order?
Yes, that’s the purpose of enabling the Gray and Black settings to get the BW click charge for grayscale only pages.

What is the difference between grayscale and black & white?
Grayscale printing means printing with black only but all the tones of the black scale. Technically “black and white” means no tonal
gradation such as if you make a black and white file in Adobe Photoshop, every pixel is either black or white. But in the world of
digital print, black and white means a black only print that you pay a lower click charge for and that has all the tones of a grayscale
print (like a photograph).

We have documents that look totally B/W but we get charged for color. There are a few pages that will have color
but a majority will be B/W. How can we make the copier print those pages in black and white?
Use the Gray and Black settings in the Fiery Job Properties to get this right. Once you have it fixed save a Preset that can be used to
set all the Job Properties from Command WorkStation or when printing from the driver.
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GCR
What does GCR stands for?
GCR = Gray Component Replacement. This means replacing some portion of gray that is made up of CMY with K only. In a neutral
color, it uses less total colorant giving a more neutral and balanced appearance. In a saturated color, this can increase saturation on
some systems removing the undesired desaturating color.

What is difference between Source GCR and Output GCR?
Source GCR uses the black generation from your source profile and will give imprecise results. It originated from the time when we
used it to try and get grayscale pages to print without color clicks. We suggest that you use the Gray and Black settings to achieve
this on newer Fiery systems.
Output GCR uses the black generation of the output profile and gives the best and most precise results. Neither Source GCR nor
Output GCR gives any more/less GCR than the profile has. You can think of them as follows:
•
•

Source GCR = “Use black generation from CMYK input profile”
Output GCR = “Use black generation from output profile”

How can I control GCR amount in Fiery Color Profiler Suite?
The black width setting technically controls GCR so that 100% width puts the most black into chromatic colors. The best practice is to
just set Max GCR then make adjustments as follows:
•

If result has too much contrast, turn K generation down to 90%

•

If result is too grainy in highlights or flesh tones, turn K start up to 15% or 20%

PDF
My expert settings do not have the PDF/X output intent. Is this only available in the newest versions?
You would only see this on an External Fiery server. Embedded Fiery systems do not have this option.

When there are multiple embedded profiles in a PDF, does that effect the RIP times in any observable way?
The processing time might slightly vary by a small amount, but not in any way you could measure.

Why is there such a drastic difference between Adobe PDF color space and Adobe Illustrator when printing,
whether you use CMYK or RGB profiles? Even differences in color output within the Adobe Creative Suite?
Adobe PDF is not a color space, it’s a file type. If you mean the colors in a PDF look different in Acrobat compared to Illustrator,
check that Acrobat’s Color Management settings in Preferences match the working spaces you have set in Illustrator Color Setup. In
Acrobat go to Edit menu > Tools > Print Production. Then click on Output preview. Are you previewing the output space you expect?
If you want to get really precise here, you could load the output profile you are using on the Fiery server and set Acrobat to preview
that. In Illustrator, make sure the settings match in Prof Setup > Customize under the View menu.
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Rendering Intent
What is the appropriate rendering intent to use if you are printing something that contains both photos and vector
images, like a company newsletter?
If you have mixed RGB images and vector graphics, we recommend that you use Relative Colorimetric.

When I have a document with Photographic images, graphs, and text, what rendering intent should I select - relative,
photographic, or presentation?
Select either Relative or Photographic if there are images, otherwise they will look wrong.

Why is there no rendering intent setting for CMYK?
Fiery servers always uses Relative Colorimetric for CMYK unless you set the Processing Method to Pure Primaries. Pure Primaries
is a bit like the Saturation rendering intent and is useful in some geographies where customers want everything very saturated, but
this results in prints that are not colorimetrically accurate and may have unnatural image appearance.

Profile Editor and Device Link
Are there quick and easy ways I can enhance profiles using Fiery Profile Editor and what else is it used for? Also,
can you explain about Device Link or alternative methods to match my profiles with the offset press better? (I have
20+ profiles so device link may not be practical)
The Fiery Profile Editor that is accessed from Command WorkStation®, edits a lookup table in the profile. It is not a full profile editor.
It was historically used to make last minute tone and color corrections to print jobs, but it becomes confusing if you use it frequently
since every time you edit, you save a new profile and you can quickly lose track of which profile went with the job. This also makes
automatic output profile selection impossible. So it’s a good tool for occasional quick fixes but should not be used frequently. If you
are calibrating the Fiery server, this will keep it consistent. If you make custom output profiles they should get your color compliant
with a reference such as GRACoL, then if you edit, you will be moving away from the reference. If you really need to create and apply
curves, do it in ImageViewer since you can apply curves to individual pages.

Can you explain device link? We currently use Oris PressMatch product to create device link that installs at DFE.
Device links can give better precision for CMYK to CMYK conversions but they take a lot longer to create, so to compare you have to
make a calibration and output profile with a tool like Fiery Color Profiler Suite. Time how long it takes then verify color with Fiery Color
Profiler Suite or Oris. Use a comparison tolerance like ISO-12647-8, the Fogra standard for digital print (don’t use something like
12647-2 which is for conventional print). Did you pass? What are the ∆E’s?
Now go make a device link and time that. Verify the same way. Is it a much better match? You have to decide if you’d rather spend
more time measuring to get a better match. Remember you need to do this for all your basic paper types.
One more factor before you decide. After it is set up, time how long it takes to re-match using each method and have the press
operator do the re-matching with each package. How long does it take? Are they willing to do this a couple of times a month for each
paper if verification fails? Extra credit: Make a device link with Fiery Color Profiler Suite iterating a few times and see if it gives the
same precision as Oris. Now have the operator update this one by launching the Fiery Color Profiler Suite Device Linker, connecting
to the Fiery server, and picking the Device Link from the Fiery server to update directly. Once they select it have them click “Iterate”,
print and measure twice and it should be re-matched. This is the most efficient way to use device links if you really think they are
essential to your success. If your operator can show you how they re-make and re-load device links from Oris for each paper over
time, then you can be successful with the package but this is beyond the skill set of most operators.
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One more point, beware of looking for matches within 1-2 ∆E. Toner digital print systems as well as conventional presses have at
least this much variation across a sheet. Grab a pressroom spectrodensitometer and go inspect some sheets if you don’t believe this.
End of Extra Credit: If you do this please post results on Fiery Forums so we can discuss.

Proofing
When proofing at my shop, we want to see the printed proof as what would be sent to the customer. Why would one
want to print a proof that doesn't look like the final product?
I think this might be related to the statement in the Webinar that we think no one proofs on the Fiery server anymore. What we mean
is no one prints proofs for conventional presses on their Fiery Driven™ digital press since they can make low cost inkjet proofs for
offset and other conventional print processes that are much more stable over time and a better financial way to make proofs with a
$500 inkjet rather than a $50,000 digital press. But you do print a copy of one on the Fiery Driven press for your customer to sign off
on and this is also a proof, just not one where you’d want to use paper white simulation and other settings. Instead, you’ll want to use
the best practice settings we share so the “proof” and the final print job look great.

Lighting
How valuable are the D50 Lighting Stickers in managing the viewing condition conversation? Do you recommend
them for critical work where the evaluator is in an unknown lighting condition?
The D50 lighting indicators tell you if the booth is 5000°K which is a good start, and yes they are a good way to see if someone is
viewing in light that is close to D50. They also remind your print buyers that you expect them to evaluate the colors, and it will match
in D50.

We have an in-house print setup, but we do not have a color booth. What would be a selling point to the powers that
be to convince them we need the color booth?
Color matching with a light booth will be more efficient and accurate. Also, print buyers expect to sign off in a light booth like they
have for the many years when buying conventional print.

Can you take a proof/print outside to view for a D50 comparison?
Yes you can; sunlight is close but a D50 light booth is more precise.

Why should we proof the output under D50 when we know the product will be viewed by the end user in other
lighting conditions? Surely, it is better to produce a satisfactory result as proofed in the destination lighting.
You can only have so many lights in your shop to check color and get customer acceptance. Professional print buyers expect this will
be D50. If you have some customers where you want prints to work in different lighting you can use the settings in Fiery Color Profiler
Suite to make profiles that work in lighting other than D50.

What UV settings are recommended?
For measuring, any UV mode can be used for calibration. The ES-1000’s default mode is M2 ; M0 is the default for ES-2000; both
work the same for calibration since the mode does not effect Density measurements. For Profiling and Color verification, M0 is
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currently the most commonly used, but M1 is the most precise way to measure and verify since it matches the UV content in the
latest D50 spec. More and more industry references such as 2013 GRACoL, 2013 SWOP, Fogra 51, and Fogra 52 use M1.

Other
How does G7 compliance support color management?
G7 does not support nor weaken color management. Some feel it makes color management work a little better or makes profiles last
longer before they need to be re-created. But if you calibrate and profile your Fiery Driven print system with a tool like Fiery Color
Profiler Suite then print with a G7-based CMYK input profile (SWOP or GRACoL), you should match not the basic “G7 Grayscale”
definition, but also at the highest level of compliance, “G7 Colorspace”. G7 calibration alone will not make a print system match G7
Colorspace tolerances.

What is the difference between workflows like job presets/virtual printers, and how do they work?
Presets configure all the Job Properties and you can use them if you are manually submitting jobs like PDFs directly to Command
WorkStation. Virtual Printers can be created based on a Preset so that printing to that network printer uses the preset. Unless you
really must have a large number of users print from the network, printing to Virtual Printers is a bit less advantageous because some
users may change settings in the print dialog for each job so that the preset values are not used. This makes print consistency and
matching color on reprints an additional challenge. The most professional shops typically have automated workflows using a tool like
Fiery JobFlow and let the automated workflow submit jobs to the Fiery server via a Hot Folder. Hot Folders are also controlled by
configuring them with a Preset.

Does the Fiery server notify you if there are any new resources/enhancements/drivers/updates that are available? If
not, where do we go to access this information?
Command WorkStation as part of the Fiery Extended Applications Package provides notifications directly to the user from
toolbar/tooltray Fiery Software Manager when new versions are available. It is also possible to check for updates from a menu option
directly in the Command WorkStation Help menu.
The latest Fiery Driver 5.0 package provides something similar for printer drivers.
For Fiery server updates to Fiery servers running Windows, a Fiery administrator can run the System Updates utility directly on a
Fiery server to automatically download and/or install Fiery server patches. For embedded Fiery servers, a Fiery administrator can
configure the Fiery server to automatically download and install Fiery server patches.

Is there a more basic webinar I can start with then work my way up? I don't even know how to use my Command
WorkStation program in order to calibrate myself.
We have a number of Webinars from the last couple of years that I recommend you check out. Please go to
webinar.efi.com/WorldofFiery to find all the session recordings.

Is the presentation available to download? Is there a recording of the session available for reference when I apply
some of these settings?
A link to the recording, a copy of the presentation and all the additional resources presented during the session is available at
webinar.efi.com/WorldofFiery2016/Mar9
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